Run Presentations

After you have created the slides and objects discussed in Chapter 3: Creating and Saving Slides, you are
ready to run an interactive presentation. Recall the five steps to presentation success. Running a
presentation session is the fourth step when using TurningPoint.

This chapter describes how to:

Run an interactive presentation using the Slide Show functionality.
Control the presentation using the Showbar.

Monitor the audience participation.

Run a Presentation

You run an interactive presentation session using PowerPoint’s Slide Show functionality.

You control the presentation session by opening and closing polling. Polling is the mechanism by which
TurningPoint accepts and tallies the responses provided by the audience using response devices.

This section describes how to:

Establish the Presentation Settings

Run the Slide Show

View Polling Status

Use the Participant Monitor

Add Slides During a Presentation Session

Use Data Slicing (View Results by Question)
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Establish the Presentation Settings

The presentation settings consist of the results data and Participant List to be used, which are important items
to check before running the presentation.

Prior to starting a presentation session, you must perform the following steps:

Clear any previous session results.
Identify the Participant List to be used.

This section explains how to perform these steps. It also demonstrates how to create the settings for the
Response Grid, an option helpful for sessions with infrared ResponseCards that gives participants
confirmation that their responses were received.

Before You Begin
You must set up the Response Devices before you begin. Find information on getting the response devices

ready in Chapter 4: Response Device and Settings Management.

If you want to track responses, you also must have created a Participant List using the Participant List Wizard.
Without a Participant List, the session collects anonymous responses and generates an automatic Participant
List. Find information on Participant Lists in Chapter 5: Track Participants and Teams.

To create the settings for the presentation session...
1 From the PowerPoint Office menu, select Open.
A window opens and displays the available files.
2 Select the TurningPoint presentation to be used, and click Open.

The file’s contents are visible in the PowerPoint window. You can use the TurningPoint Toolbar to clear any
previous results data and identify the use of response devices and a Participant List.

3 Click Reset on the TurningPoint Toolbar and select Session.

Reset Sessions

f] | Session
=] Current Slide
Ty | AllSlides

Prior to starting the presentation session, you must reset the Session or All Slides.
Resetting the Session clears any previously collected response data.

Resetting the Current Slide only clears the previously collected response data for the selected slide.
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Resetting All Slides resets the charts but does not clear any previously collected response data. The new
response data will be appended to the end of the session.

4 Optionally, from the TurningPoint Toolbar, click the Response Device drop-down menu and select an option
for testing the presentation.

Response Device Selection

i T
Response Devices =

Response Devices
Keyboard Keys 0-9
Simulated Data

Response Devices—a response device will be used during the presentation. The response device must
have been set up as outlined in Chapter 4: Response Device and Settings Management.

Keyboard Keys 0—9—you will provide input to the presentation using the keyboard keys 0-9.

Simulated Data—TurningPoint provides random responses to the presentation. TurningPoint determines
the number of responses to provide based on the number of expected devices designated in settings.
i.e. If you enter expected devices as 100, TurningPoint will provide 100 responses to each question in
your presentation. If you have a participant list selected TurningPoint will provide responses for each
participant in the list. Find more information on expected devices in Enable Remote Poll on page 125.

Note Always use Response Devices for an actual
presentation. Select Keyboard Keys 0-9 or
Simulated Data when testing a presentation.

5 From the TurningPoint Toolbar, click the Select a Participant List drop-down menu (to the right of the
Participants drop-down menu) and select the Participant List to be used.

Participant List Selection
Mew List 6.16. 2009 5.44 AM v
[Anorymous)

[Futa)

Mew List 6.16.2009 5.44 AM

Mew List 6-10-2009 2-20-35 FM
Mew List 6-16-2009 8-55-32 AM

test

Turning Technologies User Guide 218




Run a Presentation

If Auto is selected, response Device IDs and participants’ choices are collected without a Participant List. If

Anonymous is selected, only participants’ choices are collected. The default setting is Anonymous.

Note You can change the default Participant List
setting to Auto or Anonymous using the
Default Participant setting, a presentation-
level setting. Find more information on
modifying settings in Response Device and
Settings Management on page 118.

6 Optionally, click Tools on the TurningPoint Toolbar and select Settings. In the window, select Presentation

from the Settings Hierarchy.

The TurningPoint Settings window opens.

Settings Window

Answer Settings
Answer Bullet Format
Chart Settings

Auto Scale Charts

Chart Colors

Chart Labels

Chart Value Format

Standard Chart Type
Competition Settings

Defaut Number of Teams

Include Non-Responders

Maximum Responders

Participants In Leaderboard
Teams In Leaderboard

CSV Export Settings

CsV Format

Decimal Period

False

Color Scheme
Bullets

0%

Vertical

v

Restore defauit presentation settings

@ CommanSettings O All Settings

Use these settings to establish the settings for the entire presentation. You can establish the settings for a
specific slide or answer by selecting that slide or answer, respectively, from the Settings Hierarchy. Find more

information about modifying settings in Response Device and Settings Management on page 118.

These settings affect what is displayed in each box of the Response Grid. You must select the All Settings radio

button to view these settings.

Display Device IDs—select True to include the device ID field in the Response Grid.

Display Participant Names—select True to display the participant’'s name in the Response Grid.

These settings affect how the Response Grid is displayed.

Grid Opacity—enter a percentage to identify how opaque the Response Grid should be when opened.
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Grid Position—choose a selection from the menu to identify where the Response Grid should be
positioned on the screen. The selections include Top, Bottom, Left, Right, Center, TopLeft, TopRight,
BottomLeft, and BottomRight.

Grid Rotation Interval—enter the number of seconds per interval the Response Grid takes to rotate
through responses. This is needed when there are too many participants to fit in one grid.

Grid Size—identifies how wide and tall the Response Grid should be on the screen. The height and width
are measured in pixels. The default width is 800 and the height is 600.

Use Scheme Colors—Determines if Scheme Colors or Custom Colors will be displayed on the Response
Grid as established in Chart Settings.

Next Steps
After establishing the settings, you are now ready to run the presentation.

Run the Slide Show

Use PowerPoint’s Slide Show functionality to run your interactive presentation. TurningPoint accepts
responses provided by your audience, presents the results of the responses, and stores the responses in
memory.

Before You Begin
To run the slide show, you must first perform the steps listed under Establish Presentation Settings to create

the settings for your presentation session.

To run the interactive presentation...
1 From the PowerPoint Toolbar, click Slide Show > View Show.

The first slide of the presentation is shown. TurningPoint displays the Showbar in the top right corner of the
screen. The Showbar is a toolbar that provides activation buttons for polling, monitoring, and viewing
responses during the slide show.

Showbar
B - Iy n? | responses: user Feedback; alling:
_I * b | R P P g
ﬂ = |Q| & ] 0 open
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Right-click on the Showbar and move your cursor across the Showbar to display each command’s name. To
activate the command, you can select the Showbar icon or use the respective Fn key on your keyboard. Use

the commands on the Showbar as follows:

F9-Show/Hide Showbar

E |

F2-Toggle Results

-1

F3-Data Slicing

2

F6-Show the Original Chart
7'

F4-Repoll Question
@

F7-Show the Response Grid

F8-Show Non-Response Grid

F12-Display Participant Monitor
al

Turning Technologies

Closes the Showbar for the duration of the current
presentation session.

Changes the values displayed on each chart. The values can
be represented as either numbers or percents.

Shows the responses on the chart for the portion of the
audience who chose a certain response on another question.

Use this command after using the Toggle Results or Data
Slicing commands to return the chart to its original
appearance.

Clears the responses and accepts new responses from the
audience for the currently displayed question. Both the
original responses and the new responses are stored in the
session file.

Opens a Response Grid on the screen allowing you to see
which participants have responded to the question.

The size, location, visual display, and contents of the grid are
controlled in the Presentation Settings. Find more
information about settings in Establish the Presentation
Settings on page 217.

Opens a Response Grid on the screen. As each participant
responds to a question, their response box is removed from
the grid.

The size, location, visual display, and contents of the grid are
controlled in the Presentation Settings. Find more
information about settings in Establish the Presentation
Settings on page 217.

Opens the Participant Monitor. Find more information in Use
the Participant Monitor on page 225.
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F5-Insert Slide

o

Display interactive results

@

Enable/Disable ResponseWare

Qv

Press for moveable Showbar

W
|

Show animated 2D/3D Chart

e

Anonymous Polling

25
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Select the down arrow to open a drop-down menu allowing
you to select the slide type to be inserted into the
presentation. Select the icon to open a window asking for a
question and answer choices.

Expands the Showbar to display the responses, user
feedback, and polling status.

Allows the presenter to Enable/Disable ResponseWare
connections. It also allows the presenter to show or hide the
login info for ResponseWare Web.

Allows the Showbar to be moved anywhere on the Screen.

Displays the 2D/3D charts and allows the presenter to select
the chart type.

Makes the current slide anonymous. Participants info will not
be associated with their results.

2 Click the mouse to control the progress of the slide show.

The control of each slide will vary slightly depending on the objects you chose to insert when you created the
slides. Find information on slide objects and their behavior in Add Objects on page 102.

a Open polling. Polling will automatically open when you display a slide.

TurningPoint receives responses when polling is open.

Polling Open
FESpONSEs | user Feedback; polling:
] 0 open

b Click a second time to close polling and display the results.

No responses are accepted when polling is closed.

Turning Technologies

Polling Closed

FESpONSEs: user Feedback; polling:
] 0 closed
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¢ Click again to advance to the next slide.

Note To advance slides, you may use any method
PowerPoint allows, such as clicking the
mouse or pressing the space bar, arrow
keys, or Enter key.

3 Click at the end of the slides to exit from the Slide Show (or optionally, press the Esc key).

If you exit TurningPoint, the program prompts you to name and save the session results to a file. The default
location is My Documents/TurningPoint/Sessions. If you choose the default name, TurningPoint adds the date
and time to the file name. If you choose to name it specifically, the name you enter is stored.

For every session, TurningPoint automatically creates a backup copy and stores it at My
Documents\TurningPoint\Sessions\Backup.

You can set TurningPoint to automatically delete old backup sessions using the Backup Maintenance setting,
a presentation-level setting. In the Backup Maintenance field, enter the number of days you want to keep files.
TurningPoint will eliminate backup sessions created before that time. Find more information on modifying
settings in Response Device and Settings Management on page 118.

Tip  Store your session file in the Sessions folder
suggested by TurningPoint to allow the
session file to be used again by TurningPoint
to continue sessions or generate reports.
Find information about reports in Reports on
page 232.

View Polling Status

TurningPoint provides three mechanisms to see how many participants have responded to the question when
polling is open. You can expand the Showbar to see how many responses are received, you can display a
Response Grid, or you can open the Participant Monitor to see the full details of the audience responses.

This section describes using the expanded Showbar and the Response Grid to view participant results. Find
more information about the Participant Monitor in Use the Participant Monitor on page 225.

To view the polling results...

1 On the Showbar, select Display Interactive Results.
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The Showbar expands to display three additional regions that show the polling status. The number in the
Responses column is updated as responses are received.

Showbar Expansion

rESpONSES: user Feedback; pollirig:
0 0 closed

i-Display Interactive Results Displays the responses, user feedback, and polling status.
The Showbar toggles from the default setting from fully
|Q| visible to invisible on the slide.
Press for moveable Showbar Allows the Showbar to moved anywhere on the Screen.
==
Responses Identifies the number of responses received from the
respOneEE: audience. This area is visible when the slide show starts
1 unless you set the Expand Showbar setting to False.
User Feedback Shows the typed questions for ResponseWare. For
et Teadbark: ResponseCards, shows the presses of the question mark
1 key. Response Devices can only respond with the question
mark once per slide.
Polling Identifies whether polling is open or closed. The background
nalling: of this region is green when polling is open and red when
closed closed.

This step may meet all your needs for viewing polling status. You also have the option to use the Response
Grid explained in step 2, especially if you use infrared response cards.

Note A Response Counter or Response Table are
two other options for viewing polling status
that can be added when you create the
slides, before you run the presentation.

Find information about inserting objects in
slides in Add Objects on page 102.

2 Optionally, display a Response Grid during the session. Click the Show Response Grid button on the
Showbar

Turning Technologies User Guide 224



Run a Presentation

The Response Grid is a grid that is overlaid on a slide during the presentation and indicates which individuals
enter responses. Similarly, the Non-Response Grid indicates which participants have yet to respond. These
grids give the participants confirmation that their responses were received.

Response Grid

The Response Grid can be shown or hidden at will by selecting the Show Response Grid button. When this
button is selected, the Response Grid does not display.

3 After polling closes, click the mouse to advance to the next slide.

Viewing the polling status becomes disabled in the Showbar until you activate another poll. If you do not want
to display the Showbar expansion, change the Expand Showbar setting to false. Expand Showbar is a
presentation-level setting. Find more information about modifying settings in Response Device and Settings
Management on page 118.

Use the Participant Monitor

The Participant Monitor shows which participants have responded to a question and displays details about
the responses, such as the percentage of correct responses, how long participants took to respond, and
which answers they chose. Use of the Participant Monitor is optional, but it is helpful in tracking how people
are responding during a presentation.

You can access the Participant Monitor from the Showbar while the slide show is running, or from the
TurningPoint Toolbar under the Participants drop-down menu after you end the slide show.

Note If you want to limit the Participant Monitor to
your eyes only, then you can set up a second
monitor for displaying it. Find information
about setting up a second monitor in
Windows Help and Chapter 4: Response
Device and Settings Management.
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To monitor participants...

1 While running the slide show, click the Display Participant Monitor button on the Showbar.

Showbar Expansion: Display Participant Monitor

Alternatively, you can display the Participant monitor after running a slide show by selecting Participants >
Display Participant Monitor from the TurningPoint Toolbar.

TurningPoint opens the Participant Monitor window displaying Question, Participant, and Individual details
about each participant’s response and the percentage of correct answers.

Participant Monitor Window

r! TurningPoint - Participant Monitor

]
Question Overal % Corr...  TotPoint ...
1) WHAT ARE THE MEXT THREE NUMBERS? 34, 35, 36, 0% 100
2) IN WHICH GROUP ARE THE NUMBERS ORDERED FROM SMALLEST TO LARGEST? 20% 100
3) WHICH GROUP OF NUMBERS COMES AFTER 6357 26.67% 100
4) A severe or traumatic eversion of the foot/ankle will result in the injury to which structure? 10% 1
[X]
First Name Last Name Device ID Overall % TotPoint... ResponseTime  Response ~
Participant1 - 1 50% 200.00 2.59
Participant2 2 0% 0.00 2.61 1 =
Participant3 3 25% 100.00 2.61 1
Partidpant4 4 25% 100.00 261 El
Partidpant5 5 25% 100.00 261
Partidpanté 6 0% 0.00 0 -
Participant? 7 25% 100.00 0
Participants - 3 25% 100.00 0
boniales . . et o n . 2
a3l M | ]
]
Question Response
Accumulated group percent: 25%

The Question Region lists all of the questions and the overall percentage correct for the group and the total
point value per question.

The Participant Region lists the details about the participant, overall percentage of correct answers, total points
accumulated, and the response time and response for the question selected in the Question Region.

The Individual Region lists details about the response results for each participant for each question in the
presentation.

2 You can hide one or more of the three regions by selecting the close button (X) in the upper right corner.
To view a region you have hidden, select it from the View menu in the Participant Monitor window.
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When viewing the Participant Monitor while running the slide show, the Participant Monitor window must be
closed to advance to the next slide. To view the window again, press the F12 key. (Alternatively, you can press
the Alt + Tab keys, or simply end the slide show.)

Participant Monitor Window: View Menu

¥ a TurningPoint - Participant Monitor

View
v Question View
v Participant View ]
v Individual Detail View Overall % Corr...  TotPaint ...
TP WHATRRETRENEXTTHREE NUMBERS? 34, 35, 36, 0% 100
2) IN WHICH GROUP ARE THE NUMBERS ORDERED FROM SMALLEST TO LARGEST? 20% 100
3) WHICH GROUP OF NUMBERS COMES AFTER 6357 26.67% 100
4) A severe or traumatic eversion of the footfankle wil resuit in the injury to which structure? 10% 1
]
First Name Last Name Device ID Overal %  TotPoint.. ResponseTime Response ~
Farticipantl i Bt 38,485 5 5 1
Participant2 2 0% 0.00 261 1 3
Participant3 3 25% 100.00 2.61 i
Participant4 4 25% 100.00 261 3
Participant5 5 25% 100.00 261
Participants 6 0% 0.00 0 -
Participant? 7 25% 100.00 0
Participantd 8 25% 100.00 0
Particinantd a 255 0 nn n = 1L
I >
=
Question Response
1) WHAT ARE THE NEXT THREE NUMBERS? 34, 35, 36,
2) IN WHICH GROUP ARE THE NUMEERS ORDERED FROM SMALLEST TO LARGEST?
3) WHICH GROUP OF NUMBERS COMES AFTER 6357 987, 654, 321
4) A severe or traumatic eversion of the footfankle wil resuit in the injury to which structure? Posterior Talofibular...
Accumulated group percent: 25%

3 Optionally, you can expand or reduce the size of the three regions by selecting the borders and dragging
them up or down.

Add Slides During a Presentation Session

TurningPoint gives you the flexibility of adding a template or custom slide while running the presentation.
Inserting a new slide is an option available through the Showbar.

To add a new slide...
1 Insert a new slide in one of the following ways:

* Template Slide - select the arrow next to the Insert an on-the-fly slide button on the Showbar and select
the type of slide. The slide is automatically inserted after the slide you had been viewing in the
presentation.
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A drop-down menu opens from the Showbar allowing you to select the slide type to be inserted into the
presentation.

Showbar Expansion: Insert a Template Slide
m [ | responses; user feedback:
| - _|Q| - | 0 0

Yes/Mo

True/False

Yes/Mo/Abstain

Likert »
Generic L4
ResponseCard RF Channel Slide
ResponseWare Log-In

Fill in the Blank

Essay

Team Leader Board

Team Leader Board{Accumulate Points)
Participant Leader Board

Participant Leader Board{Accumulate Points)

The slide is automatically inserted.

* Custom Slide - select the Insert Slide on the Fly icon on the showbar.

Showbar Expansion: Insert a Custom Slide

The Custom Question window opens to display the fields for typing the question and answer choices to
be used on the interactive slide.

Insert Slide: Custom Question
TurningPoint - Custom Question

Enter question fext...

Enter answer text...

Cancel H Insert
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2 Enter the question in the top region of the window. Enter the answer choices in the lower region, separating
each answer with a line break.

Insert Slide: Custom Question
TurningPoint - Custom Question

Enter guestion text...

Enter answer text...

Cancel ]’ Insert

Note If you would like to reuse the presentation
with the newly added slide, save the file.
From the PowerPoint menu, select File >
Save As. If you forget, TurningPoint asks you
before closing.

3 Click Insert.

Use Data Slicing (View Results by Question)

After receiving response data, TurningPoint can cross-reference the responses of one question to another set
of responses. This function, called data slicing, is particularly useful for analyzing demographic information.
For example, you can find out whether a certain age group in the audience prefers a certain type of music. By
asking participants to identify their age group in one question, and later asking them to pick their favorite type
of music, you use data slicing to find out how many young adults in the crowd prefer R&B music, how many
seniors prefer big-band music, and so on.
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Before You Begin
To measure demographic information, insert a question slide early in the presentation that asks the audience

to identify themselves in a demographic category, such as an age group or gender.

Note To use demographic information in reports,
identify a slide as a demographic question in
the TurningPoint settings at the slide-level.
Set the Demographic setting to True. Find
more information in Response Device and
Settings Management on page 118 and
Reports on page 232.

To use data slicing...
1 Run the presentation. (From the PowerPoint menu, select View > Slide Show.)
2 Use the arrow keys to go to the primary question slide whose data you want to slice.

For example, to find out whether a certain age group in the audience prefers a certain type of music, you would
go to the question slide that asks participants to select a favorite type of music.

3 From the Showbar, select the Data Slicing button.

The Data Slicing window opens and displays a list of all questions from the interactive slides followed by their
answers.

Showbar Expansion: Data Slicing

4 Expand the question that contains the answer whose data you wish to reference in the primary question
slide, and select the answer.
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For the example, to find out how many young adults prefer each type of music, you would select the 18-35 age
range.

Data Slicing

TurningPoint - Data Shcng

= a Data Slicing (5 questions)
-5 WHAT ARE THE NEXT THREE NUMBERS? 34, 35,36, ,_ ,_
Ij IN WHICH GROUP ARE THE NUMBERS ORDERED FROM SMALLEST TO LARGEST?
@ WHICH GROUP OF NUMBERS COMES AFTER 6357
Iﬂ A severe or traumatic eversion of the footfankle will resultin the injury to which stru
(-5 Do you agree?

s ] I | [ >
(®) Question Data () Participant Groups

5 Click Select.

TurningPoint retabulates the data to show the new distribution. Instead of viewing the results for the entire
audience, you see the distribution for only the participants in the audience who submitted the selected answer.

After you have displayed a data slice, you can select a number on the keyboard corresponding to an answer
to see the slice associated with that answer. You can also cycle through groups that have responded by
pressing the G key.

6 To return the chart to its original data, press the F6 key.
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